
- 1 -Gratis basishandleiding Edius 6 - Neo 3

Nederlandstalige basishandleiding

EDIUS 6

Geert Kusters



- 2 - Geert Kusters - www.geertkusters.be

Welkom bij deze gratis basishandleiding over Edius 6!

Met behulp van deze handleiding bent u in staat
om aan Edius 6 te beginnen. Je leert:

- Edius opstarten -
- Projectinstellingen maken -

- Project beginnen -
- Beelden binnenhalen van je camera -

- Beelden monteren in de tijdlijn -

Voor meer informatie, uitgebreide oefeningen,
effecten, beeldcorrecties, multicameramontage,

audiomontage, beeld-in-beeld, split-screen,
chromakey, export naar tape/DVD/Blu-Ray/internet

en nog véééél meer
verwijs ik u graag door naar mijn uitgebreid

cursusboek over Edius 6, te koop vanaf december 2010.

Met vriendelijke groeten,
Geert Kusters.
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Deze handleiding werd samengesteld op basis van een nederlandstalige
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zijn dat sommige afbeeldingen in deze basishandleiding lichtjes kunnen afwijken.
Alle schermafdrukken werden genomen op een resolutie van 1920 x 1080 pixels.
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1Hoofdstuk 1: Beginnen met een nieuw project

1.1 Edius opstarten

Start Edius op. Bij de allereerste keer dat Edius wordt opgestart verschijnt het venster-
tje "Folder Settings":

Hier moet je instellen op welke harde schijf je wenst te werken en eventueel in welke
map.

Als je Edius hebt laten installeren in een speciaalzaak dan zal je normaal ge-
zien dit venstertje niet meer krijgen omdat deze instelling dan reeds gebeurd is.

Klik 1x met je linker muisknop op "Browse". Dit venster verschijnt:

We gaan in dit venster de video harde schijf aanduiden. We gaan géén map ingeven
omdat Edius, bij het aanmaken van een nieuw project, automatisch een map aanmaakt
op je video harde schijf met dezelfde naam als je project. Klik 1x op (Deze) Computer
om alle schijven zichtbaar te maken. Klik dan op je video harde schijf (bij mij is dit de
D:-schijf). Bevestig door 1x op OK te klikken.
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Je komt terug uit in het vorige venstertje:

Klik ook hier op OK. Dit instelvenster zal vanaf nu niet meer tevoorschijn komen. Indien
je achteraf je video harde schijf wilt wijzigen dan kan je dit doen via de instelmenu's.

Telkens je vanaf nu Edius opstart zal dit venster als eerste worden geopend. Je kan
hier kiezen of je een nieuw project wilt beginnen of aan een bestaand project wilt verder
werken.

Vermits we pas met het programma werken moeten we eerst een aantal "project
presets" aanmaken, dit zijn projectinstellingen gebaseerd op de beeldresolutie en de
beeldkwaliteit die uit je camera of videorecorder komt.
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Klik 1x met je linker muisknop op "New Project". Dit instelvenstertje wordt geopend:

Wordt dit instelvenstertje bij jou niet geopend? Dan heeft iemand de instellingen al voor
jou gemaakt (bijvoorbeeld de winkel waar je Edius hebt gekocht en die alles al voor jou
geïnstalleerd hebben). Indien je dit venster niet krijgt, ga dan direkt door naar 1.3.

1.2 Beeldformaat en renderingformaat kiezen

Nu wordt het voor mij, maar ook voor jou, zeer moeilijk. We moeten namelijk kiezen in
welk formaat we willen werken, maar dit is afhankelijk van je beeldbron (videocamera,
internetvideo, DVD-video, enz...) en je videomontagehardware, en het probleem is dat
er enorm veel verschillende formaten zijn in combinatie met een heel aantal verschil-
lende capturekaarten van Grass Valley.

Hieronder staan een aantal formaten die je misschien bekend voorkomen:

- Standaard definitie (720x576 4:3 en 720x576 16:9)
- Hoge definitie (1920x1080i en 1920x1080p)
- Hoge definitie (1280x720p en 1280x720 50p)
- Hoge definitie (1440x1080 50i)
- AVCHD (1280x720, 1440x1080 en 1920x1080)
- DVD (720x576 4:3 en 720x576 16:9)
- Internetvideo (alle mogelijke formaten)

Er zijn 3 verschillende instellingen die je moet maken, namelijk Size (beeldgrootte),
Frame Rate (aantal beelden per seconde) en Bit (kleurendiepte).
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HD: Als je in hoge definitie werkt, vink dan het vakje "HD" aan.
SD: Als je in standaard definitie werkt in fieldvolgorde "Upper Field First", vink dan

het vakje "SD" aan.
DV: Als je in standaard definitie werkt in fieldvolgorde "Lower Field First" (DV of

DVCAM), vink dan het vakje "DV" aan. Weet je het niet? Selecteer dan steeds
DV.

Opmerking: Je mag meerdere vakjes aanvinken!

Vink dan de nodige vakjes aan in de lijst van Frame Rate. De meest gebruikte
instelling bij ons in België en Nederland is 50i, maar ook 25p en 50p komen voor. Dus
welke moet je nu kiezen? Als je het niet weet kan je best de handleiding raadplegen
van je camera, want daar staat in of je in 50i, 25p of 50p werkt. Weet je het nog niet?
Neem dan contact op met de leverancier van je camera en/of Edius.

Enkele tips: Je hebt een DV of DVCAM camera: kies 50i
Je hebt een HDV camera in de resolutie 1440x1080: kies 50i
Je hebt een HDV camera in de resolutie 1280x720: kies 25p of 50p
Je hebt een HD camera in de resolutie 1920x1080: kies 50i
Je monteert zelfgemaakte DVD-beelden: kies 50i
Je monteert gekochte DVD-beelden: kies 50i of 25p
Je monteert internetbeelden: kies 50p

Dit zijn tips die voor 98% juist zijn. Nogmaals: als je niet 100%
zeker bent kan je best raad vragen aan je leverancier.

8bit of 10bit: de meeste camera's die we kennen en die we als consumer/prosumer
gebruiken filmen in 8bit-kwaliteit. High-end camera's - meestal in hogere prijsklassen -
filmen in 10bit-kwaliteit. Ook hier geldt: weet je het niet, informeer even bij de
leverancier van je camera.

Klik op de knop Volgende. Je komt uit in dit venster:
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De inhoud van dit venster hangt af van de instellingen die je in het vorige venster hebt
aangevinkt. Vink hier nu de resoluties uit die je absoluut niet wenst te gebruiken (al
dan niet in de toekomst). Ikzelf zal alles gebruiken behalve 960x720:

Klik dan op de knop Completed. Dit venster wordt geopend:

Bovenaan vind je de mogelijkheid om een naam in te geven bij de start van een nieuw
project, en onderaan vind je alle mogelijke projectinstellingen.
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1.3 Project starten

We gaan ons eerste project starten Het is nu de bedoeling dat we dit project een naam
geven. Zorg ervoor dat het vakje "Create folder with project name" is aangevinkt zodat
Edius op je video harde schijf een map aanmaakt met dezelfde naam als je project. Zo
kan je je projecten achteraf gemakkelijk terugvinden en wissen.

Geef in het vakje achter Project name de naam van je project in, bijvoorbeeld "Vakantie
in Schotland", "Huwelijk An en Piet" of "Wandeling in de Ardennen". Ikzelf hou het
simpel en geef de naam "Edius Project 01" in:

Klik dan op het icoontje dat overeenstemt met de beeldkwaliteit/-resolutie van je
camera of videorecorder. Ikzelf kies voor DV 720x576 50i 16:9 8bit:

Klik nu op OK om Edius op te starten.
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2Hoofdstuk 2: De Edius werkomgeving

Edius herbergt een aantal vensters en paletten. Op de volgende pagina krijg je een
gedetailleerd overzicht van al deze vensters.

Opmerking 1:  Het screenshot op de volgende pagina heb ik genomen met Edius op 1
computermonitor in een schermresolutie van 1920 x 1080 pixels.

Opmerking 2:  Edius beschikt over een functie waarbij het programma automatisch de
hoeveelheid ruimte op je monitor(en) kan herkennen en automatisch de vensters en
paletten schikt zodanig dat deze ruimte optimaal wordt benut. Om de functie te active-
ren ga je naar View -> Window Layout -> Normal (of druk SHIFT + ALT + L):

Opmerking 3:  Om de oefeningen in dit boek te maken hoor je te beschikken over
2 monitorvensters in Edius. Indien je maar 1 monitorvenster ziet, ga dan naar View ->
Dual Mode.

Opmerking 4: Staat een venster dat ik rechts opsom niet in beeld? Ga dan naar
View -> Palette -> Show All.
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1. Linker monitorvenster en tevens opnamevenster :  dit venster heeft twee
functies. Als linker monitorvenster dient het om de opgenomen beelden op maat te
knippen alvorens ze in de tijdlijn te plaatsen. Als opnamevenster kunnen we hiermee de
videobeelden van onze camera of recorder inladen op harde schijf (op voorwaarde dat
we nog over een camera beschikken die opneemt op tape).
2. Rechter monitorvenster :  hier zien we het resultaat van de montage in de tijdlijn.
3. Tijdlijn :  hier wordt de montage opgebouwd door er beelden, titels, foto's en muziek
in te plaatsen.
4. Informatievenster :  als je een item in de tijdlijn selecteert kan je in dit venstertje
alle mogelijke informatie aflezen, zoals de duur van het item en welke effecten erop
toegepast werden.
5. Bin :  dit is een groot opslagvenster waar alle bronmateriaal in verzameld wordt dat
kan dienen om te monteren. Alle beelden, foto's, titels, muziekstukken enz... worden in
dit venster weergegeven zodanig dat je alles gemakkelijk terugvindt.

Alvorens verder te gaan in Edius moeten we een belangrijke instelling controleren. Je
kan in Edius namelijk wel of niet monteren in Ripple Mode . Als de Ripple Mode
geselecteerd is dan zal Edius, wanneer je een clip verwijdert uit de tijdlijn, automatisch
het gat proberen te dichten door de rest van de montage dat achter de verwijderde clip
staat naar voor te schuiven. Dat lijkt gemakkelijk, maar hier zijn een aantal nadelen
aan verbonden want het dichten van een gat in de tijdlijn kan je best manueel doen om
fouten te voorkomen. Ripple Mode moet dus uitgeschakeld worden. Klik hiervoor 1x op
het aangeduide icoontje zodat er een oranje streep door verschijnt:
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3Hoofdstuk 3: Het inladen van je videobeelden op harde schijf

Heden ten dage zijn er meerdere mogelijkheden om de videobeelden van je camera
over te brengen naar je montagecomputer. We moeten onderscheid maken tussen
2 zaken:

     1. Werkt je videocamera nog met tapes om op te filmen
     2. Werkt je videocamera met een schijfje, harddisc, optische disc of

geheugenkaart om op te filmen

Indien je werkt met camera type 2, dan is het procédé het gemakkelijkste. Sla al deze
pagina's over en blader direkt door naar punt 3.4: Het inladen van beelden van
schijfje of kaart.

Werk je nog met camera type 1, volg dan al de onderstaande punten tot en met puntje
3.3 Capturen starten . Punt 3.4 mag je overslaan.

Sluit je camcorder of videorecorder aan en zet het apparaat aan. Zorg ervoor dat er een
opnametape insteekt en dat alle connecties in orde zijn. Het inladen van beelden op
harde schijf heet vanaf nu Capturen .

3.1 Scèneherkenning

Je kan in Edius scèneherkenning activeren waardoor alle afzonderlijke clips op je
opnametape worden herkend en als aparte bestanden op de harde schijf worden be-
waard. Het grote voordeel is dat elk beeld apart in de Bin tevoorschijn komt zodat je
een mooi overzicht hebt van alle beelden op je opnametape(s).

Op de volgende pagina zie je het verschil tussen een tape van 60 minuten die werd
opgenomen mét scèneherkenning en dezelfde tape die werd opgenomen zonder
scèneherkenning.

Scèneherkenning is niet beschikbaar bij het capturen van VHS, S-VHS,
Video8, Hi8, Betacam, HDMI, enz...). Ook bij kopies van digitale tapes kan
het zijn dat scèneherkenning niet beschikbaar is.
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Zonder scèneherkenning:  De tape van 60 minuten wordt door één enkel icoontje
weergegeven in de bin. Dit maakt het een stuk omslachtiger om te monteren omdat je
alle beelden zelf moet gaan uitzoeken en uit dit lange stuk knippen.

Met scèneherkenning:  Elk afzonderlijk beeld van de tape wordt voorgesteld door een
apart icoontje. Zo krijg je een perfect overzicht van alle beelden die je hebt ingeladen en
kan je ze gemakkelijker monteren.

Hoe je scèneherkenning kan activeren en deactiveren leer je in het uitgebreid cursus-
boek over Edius 6.
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3.2 De juiste video-ingang selecteren

Het is nu de bedoeling dat we in Edius instellen langs welke ingang van de computer
onze beelden binnen zullen komen, dus de ingang waar de verbindingskabel van je
camera (of videorecorder) is verbonden met je PC.

Zorg ervoor dat je camera is aangesloten aan je computer, deze in de afspeelstand
staat, aan staat (liefst op voeding en niet op batterij) en er een tape in steekt die je
wenst te capturen. Ga daarna naar Settings -> System Settings:

In het venster dat tevoorschijn komt open je links het keuzemenu Hardware (klik
hiervoor op het plusteken ervoor) en klik je daarna op Device Preset :

Klik nu onderaan op de knop New om een ingang te selecteren.
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1. Je wilt DV , DVCAM of DVCPRO beelden capturen via de FireW ire-aansluiting

Geef de naam DV, DVCAM of DVCPRO capture in en klik op Volgende:

In het volgende venster maak je de volgende instellingen:

Interface: Generic OHCI

Stream: Niet veranderen

Video Format: 720x576 50i

Codec: DV (HW)

File Format: Indien deze instelling instelbaar is: AVI

Proxy File: Indien deze instelling zichtbaar en instelbaar is: No

Audio Format: Niet veranderen

Audio Input: Niet veranderen

Convert 16Bit/2ch: Aanvinken indien je camera op heeft genomen in een andere
audiostandaard en je wenst deze te converteren naar 16Bit
2 kanalen. Indien je het niet weet, laat dit dan uitgevinkt.
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Het instelvenster ziet er nu zo uit:

Klik op Volgende om naar het volgende instelmenu te gaan. In dit venster maak je de
volgende instellingen:

Interface: Generic OHCI

Stream: Niet veranderen

Video Format: Voor DV/DVCAM 4:3: [DV] 720x576 50i 4:3
Voor DV/DVCAM 16:9: [DV] 720x576 50i 16:9
Voor DVCPRO 4:3: [DVCPRO50] 720x576 50i 4:3
Voor DV/DVCAM 16:9: [DVCPRO50] 720x576 50i 16:9

Audio Format: 48000Hz/2ch/16bit

Audio Output: Niet veranderen

Klik op Volgende om naar het laatste venster te gaan. Hier krijg je een opsomming van
de gemaakte instellingen. Klik als laatste op Completed om het venster af te sluiten en
dan op OK om het hoofdmenu ook af te sluiten.

Je bent nu klaar om via FireWire te capturen. Voor verdere instructies, blader door naar
3.3 Capturen starten .
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2. Je wilt HDV -beelden capturen via de FireW ire-aansluiting

Geef de naam HDV capture in en klik op Volgende:

In het volgende venster maak je de volgende instellingen:

Interface: Generic HDV

Stream: Niet veranderen

Video Format: HDV 1080 50i: 1440x1080 50i
HDV 720 25p: 1280x720 25p
HDV 720 50p: 1280x720 50p

Codec: Canopus HQ. Klik op Settings en vink in het venstertje dat tevoor-
schijn komt het bolletje Online(Fine) aan. Klik op OK om te
bevestigen

File Format: Niet veranderen

Proxy File: Indien deze instelling zichtbaar en instelbaar is: No

Audio Format: Niet veranderen

Audio Input: Niet veranderen
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Convert 16Bit/2ch: Aanvinken indien je camera op heeft genomen in een andere
audiostandaard en je wenst deze te converteren naar 16Bit
2 kanalen. Indien je het niet weet, laat dit dan uitgevinkt.

Het instelvenster ziet er nu zo uit:

Klik op Volgende om naar het volgende instelmenu te gaan. In dit venster maak je de
volgende instellingen:

Interface: Generic OHCI

Stream: Niet veranderen

Video Format: Indien beschikbaar als instelling: 1440x1080 50i
Anders stel je dit in: [DVCPRO HD] 1440x1080 50i

Audio Format: Niet veranderen

Audio Output: Niet veranderen

Klik op Volgende om naar het laatste venster te gaan. Hier krijg je een opsomming van
de gemaakte instellingen. Klik als laatste op Completed om het venster af te sluiten en
dan op OK om het hoofdmenu ook af te sluiten.

Je bent nu klaar om HDV via FireWire te capturen.
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3.3 Capturen starten

Eerst moeten we onze video-ingang preset (die we net hiervoor hebben aangemaakt)
selecteren. Ga hiervoor naar Capture -> Select Input Device:

Dit venster komt tevoorschijn (de inhoud van dit venster verschilt bij jou indien je
meerdere/andere video-ingang presets hebt aangemaakt dan ik):

Selecteer de gewenste video-ingang en klik op OK. Indien Edius je onderstaand
venstertje geeft dan geef je hier de naam in van de tape die in je camera steekt.

Met behulp van de bedieningsknoppen onderaan het capturevenster (het linker monitor-
venster) kan je vanaf nu je camcorder of videorecorder bedienen.
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! Als je analoge beelden wilt capturen (composiet, s-video of component), of
beelden via HDMI of SDI, dan is het niet mogelijk om je camcorder
of videorecorder te bedienen en zullen de besturingsknopjes niet actief zijn.

1. Shuttle: Als je dit blokje naar links schuift zal de tape terugspoelen terwijl je het
beeld kan zien in het monitorvenster. Als je dit blokje naar rechts schuift
zal de tape vooruitspoelen terwijl je het beeld kan zien in het monitor-
venster. Hoe meer je naar links of rechts schuift, hoe sneller de tape zal
spoelen. Door het blokje los te laten pauzeer je de tape.

2. Stop: De stopknop.

3. Rewind: Hiermee spoel je de tape snel terug. Als je op deze knop klikt terwijl de
tape aan het afspelen is of in pauze staat wordt er teruggespoeld terwijl
je het beeld kan volgen in het monitorvenster. Als je op deze knop klikt
terwijl de tape in stop staat zal er worden teruggespoeld zonder beeld,
en in de meeste gevallen zal de tape dan ook veel sneller worden ge-
spoeld dan wanneer je het beeld kan volgen.

4. Previous frame: Door op dit knopje te klikken kan je het beeld frame per
frame terugspoelen. Je moet dus 25 maal klikken om het
beeld 1 seconde terug te spoelen.
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5. Play: De playknop. Hiermee kan je de tape afspelen aan de normale snelheid.

6. Next frame: Door op dit knopje te klikken kan je het beeld frame per frame
vooruit spoelen. Je moet, net zoals het knopje Previous frame,
25 maal klikken om het beeld 1 seconde vooruit te spoelen.

7. Fast Forward: Hiermee spoel je de tape snel vooruit. Als je op deze knop klikt
terwijl de tape aan het afspelen is of in pauze staat wordt er
vooruit gespoeld terwijl je het beeld kan volgen in het monitor-
venster. Als je op deze knop klikt terwijl de tape in stop staat zal er
worden vooruit gespoeld zonder beeld, en in de meeste gevallen zal
de tape dan ook veel sneller worden gespoeld dan wanneer je het
beeld kan volgen.

8. Pause: De pauzeknop. Hiermee pauzeer je het beeld en dit beeld kan je
bekijken in het monitorvenster.

9. Capture: De captureknop. Klik hier op om de opname naar harde schijf te
starten. De sneltoets om het capturen te starten is F9.

Je bent nu klaar om te capturen, en je mag je eerste tape dan ook nu inladen. Spoel de
tape tot de positie van waar je wilt capturen op harde schijf en klik dan op de capture-
knop. Tijdens het capturen verschijnt dit venster:
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We zullen even alle informatie in dit venster overlopen:

1 De harde schijf is in opname.

2 Het aantal uren, minuten, seconden en frames dat de harde schijf reeds opgeno-
men heeft vanaf het moment dat je op de captureknop hebt geklikt. Bij mij heeft
de harde schijf momenteel 3 minuten, 40 seconden en 17 frames opgenomen.

3 Device Preset:  De gekozen video-input preset.

4 Het gekozen opnameformaat.

5 Reel Name:  De naam van je tape. Deze kon je zonet ingeven als de instelling
Confirm Reel Name Setting after Setting Device Preset is aangevinkt.

6 In/Out/Dur:  Hier geeft Edius aan op welk inpunt op de tape de huidige clip
begint, op welk uitpunt het eindigt en hoe lang de clip duurt. Dit wordt echter
enkel weergegeven bij het Batch Capturen van een tape. Omdat Batch Capture
echter bijna niet meer gebruikt wordt in deze tijd ga ik hier niet verder op in.

7 Type:  Er wordt bij mij zowel video als audio tegelijkertijd opgenomen.

8 Automatic detection:  Enable (File split) betekent dat scéneherkenning is ge-
activeerd.
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9 File:  De naam van de opgenomen clip op harde schijf (deze naam kan ik na de
opname nog veranderen).

10 Available Capture Time:  De hoeveelheid video je nog kan capturen op je harde
schijf. Uiteraard zal dit getal bij jou verschillen. Het is afhankelijk van de hoeveel-
heid harde schijfruimte je beschikbaar hebt en in welk formaat je aan het
capturen bent.

11 Disk:  Het aantal procent harde schijfruimte je nog beschikbaar hebt.

12 File Split Count:  Het aantal verschillende beelden er werden gecaptured,
gesplitst door de instelling scéneherkenning.

13 Current Timecode:  De huidige tijdcode op de tape die in de camera steekt.

14 Set Mark:  Als je op deze knop klikt kan je een markeerpunt met commentaar-
tekst toevoegen aan de clip die op dit moment gecaptured wordt. Dit is eigenlijk
een herkenningspunt in de clip dat je kan gebruiken om dit punt later gemakke-
lijk tijdens de montage in de bin terug te vinden.

15 Hier verschijnt de tijdcode van de gemarkeerde clip en het markeringsnummer.

16 Stop: De stopknop. Klik hier om het capturen te stoppen.

Als je op de stopknop hebt geklikt verschijnt dit venstertje (de inhoud zal bij jou ver-
schillen):

Hierin vind je de naam die Edius automatisch aan het opgenomen beeld heeft gegeven.
Cap staat voor Capture
0913 staat voor de negende maand en de dertiende dag, dus 13 september
(dit is de dag dat ik dit screenshot heb genomen voor dit boek)
000 staat voor de automatische nummering

Verander de naam in, bijvoorbeeld de naam van je tape (bij mij is het Tape1):

Druk dan op enter of klik op OK. De clip(s) komen nu terecht in de bin. We kunnen nu
beginnen te monteren!
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3.4 Het inladen van beelden van schijfje of kaart

Deze werkwijze geldt voor consumer en prosumer camera's die opnemen op een
schijfje, harddisk of geheugenkaart.

Eerst en vooral moet je de videobeelden die van je schijf naar je video harde schijf
kopiëren.

1. Heeft je camera een USB-aansluiting? Sluit deze dan via de bijgeleverde kabel
aan aan je PC.

2. Neemt je camera op op een geheugenkaart en heb je een kaartlezer in je PC?
Dan kan je deze kaart ook rechtstreeks in je PC steken.

3. Neemt je camera op op een DVD-schijfje? Dan kan je deze schijf rechtstreeks
in je PC steken.

Kopieer of verplaats de videobeelden van je camera naar een map naar keuze op je
video harde schijf. Eens de videobeelden op je video harde schijf staan dubbelklik je op
een willekeurige plaats in het grote, lege gedeelte van de bin dat ik voor de gelegenheid
gearceerd heb:
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!

Dit venstertje verschijnt:

Ga naar de map waar de clips zich bevinden, duidt ze allemaal aan en klik dan op de
knop 'Openen'. Het venstertje verdwijnt en alle clips komen automatisch terecht in de
bin, klaar voor de montage.

We kunnen nu beginnen te monteren!

Hoe je XDCAM (HD) en XDCAM EX-beeldmateriaal moet inladen in Edius
staat volledig beschreven in het uitgebreid cursusboek van Edius 6,
beschikbaar vanaf december 2010.
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4Hoofdstuk 4 : De montage

4.1 Bepalen van inpunt en uitpunt

We gaan je eerste clip bekijken en een inpunt en uitpunt  bepalen. Dit betekent dat
we een welbepaald gedeelte van deze clip zullen aanduiden en enkel dit gedeelte in de
tijdlijn verwerken. Om een in- en uitpunt te kunnen ingeven moet de clip in het linker
monitorvenster worden geplaatst. Hiervoor bestaan 2 methoden.

Methode 1 :  Klik met je linkermuisknop op je clip in de bin, houd de muisknop inge-
drukt en sleep de clip tot in het linker monitorvenster:

Methode 2 :  Dubbelklik je clip in de bin. Automatisch zal Edius de clip naar het linker
monitorvenster overbrengen.

In het monitorvenster kan je het eerste beeld van je clip zien:



- 27 -Gratis basishandleiding Edius 6 - Neo 3

De bedieningsknopjes onderaan het monitorvenster die je ter beschikking had bij het
capturen dienen nu om de clip te bekijken en in de clip te navigeren :

1. Shuttle: Als je dit blokje naar links schuift zal de clip terugspoelen terwijl je
het beeld kan zien in het monitorvenster. Als je dit blokje naar rechts
schuift zal de clip vooruitspoelen terwijl je het beeld kan zien in het
monitorvenster. Hoe meer je naar links of rechts schuift, hoe sneller de
clip zal spoelen. Door het blokje los te laten pauzeer je de clip.

2. Stop: De stopknop. Is in principe nutteloos bij het navigeren in een clip.

3. Rewind: Hiermee spoel je de clip snel terug.

4. Previous frame: Door op dit knopje te klikken kan je het beeld frame per
frame terugspoelen. Je moet dus 25 maal klikken om het
beeld 1 seconde terug te spoelen.

5. Play: De playknop. Hiermee kan je de clip afspelen aan de normale snelheid.
Door nogmaals op deze knop te drukken pauzeer je het beeld.

6. Next frame: Door op dit knopje te klikken kan je het beeld frame per frame
vooruit spoelen. Je moet, net zoals het knopje Previous frame,
25 maal klikken om het beeld 1 seconde vooruit te spoelen.
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7. Fast Forward: Hiermee spoel je de clip snel vooruit.

8. Loop: Hiermee zal de clip in een lus blijven afspelen.

We gaan het zelf eens proberen. Klik 1x met je linkermuisknop op de playknop. Het
beeld inclusief klank begint af te spelen in het linker monitorvenster. Indien je beschikt
over de nodige hardware kan je beeld en geluid meevolgen op een extern televisie-
toestel.

Waar je vooral op moet letten is het omgekeerde driehoekje dat bij het afspelen van
links naar rechts schuift:

Bij Grass Valley noemen ze dit de Slider  (schuiver). De technische term voor dit
driehoekje is echter de Current Time Indicator  of CTI. Ikzelf noem dit het scrub-
blokje , omdat het schuiven doorheen een clip of montage scrubben  heet.

Dit scrubblokje kan je manueel verschuiven. Klik het driehoekje aan met je linkermuis-
knop, houd de muisknop ingedrukt en sleep naar links of naar rechts. Op die manier
kan je snel doorheen een clip navigeren. Als je het blokje loslaat pauzeert het beeld
automatisch.

Dit scrubblokje vervangt bijna alle navigatieknopjes die zich onder het monitorvenster
bevinden, behalve de playknop en de knoppen "Previous frame" en "Next frame".
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Je hebt nu alle kennis in huis om zelf het scrubblokje te bedienen. Plaats dit blokje op
de tijdcode waar je je clip wilt laten beginnen in de tijdlijn. Je kan deze tijdcode aflezen
op 2 plaatsen, namelijk in het groot kader in het beeld (1) en linksonder in het
monitorvenster (2):

Even wat meer uitleg over de grote informatiebalk die in het monitorvenster staat. Deze
geeft namelijk 4 zaken weer :

     1. Ply  betekent Player  want het linker monitorvenster noemt player venster bij
Grass Valley. Het rechter monitorvenster is de Recorder , daarom staat er in de
informatiebalk aan de rechterkant dan ook Rcd.

     2. De tijdcode van het scrubblokje.

     3. De huidige toestand van de clip (pauze, play of spoelen).

     4. De uitslaande balkjes geven het volumeniveau weer.
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Als deze informatiebalk bij jou niet zichtbaar is dan kan je deze zichtbaar maken via
View -> On Screen Display -> Status of via CTRL + G. Je kan de balk op dezelfde
manier ook terug verwijderen uit het beeld:

Klik nu 1x met je linkermuisknop op de knop IN onderaan het linker monitorvenster om
het INPUNT vast te leggen:

Je kan ook op de letter i van je toetsenbord drukken. Dat geeft hetzelfde resultaat:
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Het inpunt werd vastgelegd, en je kan dat op 2 plaatsen zien:

Navigeer nu naar de tijdcode waar je de clip wilt laten eindigen in de tijdlijn:
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Plaats op deze positie een uitpunt door 1x met je linkermuisknop op het knopje OUT
te klikken:

...of druk op de letter o van je toetsenbord:

Je kan ook het uitpunt op 2 plaatsen bekijken:
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We gaan nu Clip 01 in de tijdlijn plaatsen. Klik hiervoor met je linkermuisknop op een
willekeurige plaats op het beeld in het linker monitorvenster (1), houd de muiskop
ingedrukt en sleep de clip (2) naar het begin van spoor 1 VA van de tijdlijn (3):

Zoals je kan zien staat de eerste clip mooi in de tijdlijn:
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Wat ook meteen opvalt is het rechter monitorvenster. Ook dit venster geeft vanaf nu
beeld weer omdat dit venster de inhoud van de tijdlijn toont :

Als je geen beeld ziet in het rechter monitorvenster dan staat Clip 01 niet vol-
ledig links in de tijdlijn. Klik in dat geval Clip 01 aan met je linkermuisknop,
houd de muisknop ingedrukt en sleep de clip naar links totdat je niet meer
verder kan slepen.

De clip in de tijdlijn bestaat uit 3 delen. Op onderstaande afbeelding heb ik de 3 delen
aangeduid:

1. Het videogedeelte van de clip. Het klein beeldje vooraan toont het beeld waar het
inpunt op staat, het laatste beeldje toont het beeld waar het uitpunt op staat.
2. Het audiogedeelte van de clip. Deze groen-blauwe balk toont aan dat er klank bij
Clip 01 hoort.
3. De effectlijn. Deze balk is nu nog leeg, maar als we in een later stadium effecten
gaan toevoegen dan kunnen we aan deze balk zien dat er een effect op Clip 01 staat.

Effecten plaatsen en instellen komt volledig aan bod in het uitgebreid cursusboek
Edius 6.

Herhaal nu alle stappen van dit hoofdstuk om je clips in de tijdlijn te monteren. Indien je
slechts over 1 grote clip beschikt in je bin (scèneherkenning gedeactiveerd) dan laat je
deze clip gewoon in het linker monitorvenster staan, terwijl je telkens opnieuw een
inpunt en uitpunt plaatst. Sleep de clip dan naar de tijdlijn. Enkel tussen in en uit wordt
gesleept. Laat de clip staan en geef een nieuw inpunt en uitpunt in. Sleep deze nieuwe
clip ook weer naar de tijdlijn. Herhaal al deze stappen totdat je klaar bent.

!
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4.2 De montage bekijken

Speel de montage af door op de playknop van het rechter monitorvenster te klikken:

Terwijl de montage afspeelt zie je ook hier een klein scrubblokje voorbij schuiven :

Dit scrubblokje duidt aan waar je je bevindt bij het afspelen van de tijdlijn. Maar dit klein
blokje is minder belangrijk want tegelijkertijd schuift er in de tijdlijn een grote scrubblok
voorbij met een verticale lijn aan.
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Het klein scrubblokje van het rechter monitorvenster heeft exact dezelfde functie als de
grote scrublijn in de tijdlijn, namelijk aanduiden waar je je bevindt in de tijdlijn:

Het klein scrubblokje vergeten we vanaf nu omdat we enkel de grote blok gaan gebrui-
ken. Deze grote blok inclusief de verticale lijn noemen we vanaf nu de scrublijn  en
speelt een belangrijke rol bij de verdere montages. Niet alleen duidt deze aan waar we
ons bevinden in de tijdlijn, maar tevens kunnen we deze scrublijn vastnemen en zelf
positioneren om bijvoorbeeld snel naar een bepaalde passage te gaan en dit te bekij-
ken.
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Om de scrublijn te verplaatsen klik je met je linkermuisknop op de omgekeerde
driehoek, houd je de muisknop ingedrukt en sleep je naar links of naar rechts:

Als je de scrublijn niet meer kan terugvinden (bij langere montages kan dit al eens
gebeuren) dan klik je 1x met je linkermuisknop op de tijdcodebalk bovenaan de tijdlijn.
De scrublijn komt tevoorschijn op de plaats waar je geklikt hebt:
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4.3 Het project bewaren

Bewaar het project onder dezelfde naam (die je in het begin van deze handleiding hebt
gegeven) door CTRL + S te drukken op je toetsenbord, ofwel door te klikken op File ->
Save Project:

4.4 Het project afsluiten

We gaan het project en tegelijkertijd ook Edius afsluiten. Dit kan op veel manieren,
maar de gemakkelijkste is via File -> Exit:

Edius sluit zichzelf af en je komt terug uit op het bureaublad van Windows.
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Tot zo ver deze basishandleiding over Edius 6.

Meer informatie,
oefeningen, weetjes en tips

vind je in het uitgebreid Edius 6 cursusboek,
beschikbaar vanaf december 2010.

Check regelmatig www.geertkusters.be
voor de status van dit boek.


